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Manage Circuits

Note The terms “Unidirectional Path Switched Ring” and “UPSR” may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as “Path Protected Mesh Network” and “PPMN,” refer generally to Cisco’s 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to manage Cisco ONS 15454 electrical, optical (OC-N), Ethernet, and virtual 
concatenated (VCAT) circuits. 

Before You Begin
To create circuits, see Chapter 6, “Create Circuits and VT Tunnels.”

To clear any alarm or trouble conditions, refer to the Cisco ONS 15454 Troubleshooting Guide.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A199 Locate and View Circuits, page 9-2—Complete as needed.

2. NTP-A200 View Cross-Connect Card Resource Usage, page 9-2—Complete as needed.

3. NTP-A151 Modify and Delete Circuits, page 9-4—Complete as needed to edit a circuit name; 
change the active and standby colors of spans; change signal fail, signal degrade thresholds, 
reversion time, and PDI-P settings for path protection circuits; or add or delete a VCAT member.

4. NTP-A278 Modify and Delete Overhead Circuits, page 9-4—Complete as needed to change a tunnel 
type, repair an IP circuit, or delete overhead circuits.

5. NTP-A78 Create a Monitor Circuit, page 9-5—Complete as needed to monitor traffic on primary 
bidirectional circuits.

6. NTP-A79 Create a J1 Path Trace, page 9-6—Complete as needed to monitor interruptions or 
changes to circuit traffic.

7. NTP-A293 Create a J2 Path Trace, page 9-7—Complete as needed to monitor interruptions or 
changes to circuit traffic.

8. NTP-A298 Reconfigure Circuits, page 9-9—Complete as needed to reconfigure circuits.

9. NTP-A301 Merge Circuits, page 9-10—Complete as needed to merge circuits.
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NTP-A199 Locate and View Circuits
NTP-A199 Locate and View Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 at a node on the network where you want 
to view the circuits. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 As needed, complete the “DLP-A416 View Circuit Information” task on page 21-2.

Step 3 As needed, complete the “DLP-A131 Search for Circuits” task on page 18-14.

Step 4 As needed, complete the “DLP-A262 Filter the Display of Circuits” task on page 19-44.

Step 5 As needed, complete the “DLP-A229 View Circuits on a Span” task on page 19-18.

Step 6 As needed, complete the “DLP-A417 View the BLSR Squelch Table” task on page 21-5.

Step 7 As needed, complete the “DLP-A430 View Spanning Tree Information” task on page 21-9.

Stop. You have completed this procedure.

NTP-A200 View Cross-Connect Card Resource Usage

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 at the node where you want to view the 
cross-connect card resource usage. If you are already logged in, continue with Step 2.

Step 2 Click the Maintenance > Cross-Connect > Resource Usage tabs.

Purpose This procedure allows you to locate and view circuits and spanning tree 
information. 

Tools/Equipment None

Prerequisite Procedures Circuit creation procedure(s) in Chapter 6, “Create Circuits and VT 
Tunnels” 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This procedure allows you to view the percentage of cross-connect card 
resources used by circuits that traverse or terminate at an ONS 15454. 

Tools/Equipment XCVT or XC10G cards must be installed.

Prerequisite Procedures DLP-A37 Install the XCVT or XC10G Cards, page 17-45

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-A200 View Cross-Connect Card Resource Usage
Step 3 In the Summary area of the Resources Usage tab, view the following information:

• STS-1 Matrix—(XCVT and XC10G.) Provides the percent of the cross-connect card STS-1 path 
resources that are in use. 288 STS-1 paths are available for XCVT cards; 1152 STS-1 paths are 
available for XC10G cards.

• VT Matrix Ports—(XCVT and XC10G.) Provides the percent of the cross-connect card VT matrix 
ports that are in use. Each port is one STS in size, and each can transport 28 VT1.5s. 24 VT matrix 
ports are available for the XCVT and XV10G cards.

• VT Matrix—(XCVT and XC10G.) Provides the percent of the VT matrix resources that are in use. 
672 are available, which is the number of VT matrix ports (24) multiplied by the number of VT1.5s 
in an STS (28).

Step 4 In the VT Matrix Port Detail section, you can view details of the VT Matrix Port usage:

• Drop—Identifies the source slot, port, and STS.

• Tunnel Name—VT tunnels use VT matrix ports on the tunnel source and destination nodes (VT 
tunnels do not use matrix resources on pass-through nodes). If the port is used by a VT tunnel, the 
tunnel name will appear here.

• % Used—Shows the percent of the matrix port that are in use. Each matrix port can carry 28 VT1.5s, 
so for example, if one STS carries seven VT1.5 circuits, the matrix port will be 25 percent used.

• Usage—Shows the port usage. For example, if one STS carries seven VT1.5 circuits, the matrix port 
will show that 7 of 28 are in use.

Step 5 As needed, you can perform the following actions:

• Click the Refresh button to see an updated XC Resources view. For example, if other users create 
circuits while you view the XC Resources tab, click Refresh to see the effects those circuits have 
on the VT matrix usage.

• Click the Delete button to delete STSs that use VT matrix resources but no longer carry VT circuits. 
This occasionally occurs when many VT circuits are added and deleted over a period of time. 
Stranded STSs appear as STSs with 0 percent usage in the VT Matrix Port Detail area. If stranded 
STSs appear, click the STS, then click Delete to free VT matrix capacity.

Note The Delete button requires a Superuser security level.

Note VT tunnels may appear as STSs with 0 percent capacity used. These cannot be deleted. 

Stop. You have completed this procedure.
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NTP-A151 Modify and Delete Circuits 

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 at a node containing the circuit that you 
want to modify. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-A230 Change a Circuit Service State” task on page 19-19.

Step 3 As needed, complete the “DLP-A231 Edit a Circuit Name” task on page 19-20.

Step 4 As needed, complete the “DLP-A232 Change Active and Standby Span Color” task on page 19-21.

Step 5 As needed, complete the “DLP-A233 Edit Path Protection Circuit Path Selectors” task on page 19-22.

Step 6 As needed, complete the “DLP-A263 Edit Path Protection Dual-Ring Interconnect Circuit Hold-Off 
Timer” task on page 19-45.

Step 7 As needed, complete the “DLP-A333 Delete Circuits” task on page 20-21.

Step 8 As needed, complete the “DLP-A437 Change a VCAT Member Service State” task on page 21-15.

Step 9 As needed, complete the “DLP-A384 Add a Member to a VCAT Circuit” task on page 20-65.

Step 10 As needed, complete the “DLP-A385 Delete a Member from a VCAT Circuit” task on page 20-69.

Stop. You have completed this procedure.

NTP-A278 Modify and Delete Overhead Circuits

Caution Deleting circuits can be service affecting and should be performed during a maintenance window.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 for a node on the network where you want 
to delete the circuit. If you are already logged in, continue with Step 2.

Purpose This procedure modifies and deletes ONS 15454 circuits and tunnels.

Tools/Equipment None

Prerequisite Procedures Circuits must exist on the network. See Chapter 6, “Create Circuits and VT 
Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure changes the tunnel type, repairs IP circuits, and deletes 
overhead circuits.

Tools/Equipment None

Prerequisite Procedures Circuits must exist on the network. See Chapter 6, “Create Circuits and VT 
Tunnels.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A78 Create a Monitor Circuit
Step 2 As needed, complete the “DLP-A332 Change Tunnel Type” task on page 20-20.

Step 3 As needed, complete the “DLP-A336 Repair an IP Tunnel” task on page 20-23.

Step 4 As needed, complete the “DLP-A334 Delete Overhead Circuits” task on page 20-22.

Stop. You have completed this procedure.

NTP-A78 Create a Monitor Circuit

Note Monitor circuits cannot be used with EtherSwitch circuits. 

Note For unidirectional circuits, create a drop to the port where the test equipment is attached.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 at a node on the network where you will 
create the monitor circuit. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab.

Step 4 Choose the bidirectional (two-way) circuit that you want to monitor and click Edit.

Step 5 Verify that the circuit name is no longer than 44 characters. Monitor circuits append a “_MON” to the 
circuit name. If the name is longer than 44 characters, edit the name in the Name field, then click Apply.

Step 6 In the Edit Circuit window, click the Monitors tab.

The Monitors tab displays ports that you can use to monitor the circuit. 

Note The Monitor tab is only available when the circuit has a DISCOVERED status. 

Step 7 On the Monitors tab, choose the monitor source port. The monitor circuit will display traffic coming into 
the node at the port you choose. 

Note In Figure 9-1, you would choose either the DS1-14 card (to test circuit traffic entering Node 2 
on the DS1-14) or the OC-N card at Node 1 (to test circuit traffic entering Node 1 on the OC-N 
card).

Purpose This procedure creates a monitor circuit that monitors traffic on primary, 
bidirectional circuits. 

Tools/Equipment None

Prerequisite Procedures Bidirectional (two-way) circuits must exist on the network. See Chapter 6, 
“Create Circuits and VT Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A79 Create a J1 Path Trace
Step 8 Click Create Monitor Circuit.

Step 9 In the Circuit Destination section of the Circuit Creation wizard, choose the destination node, slot, port, 
STS, VT, or DS1 for the monitored circuit. 

Note In the Figure 9-1 example, the monitor circuit destination is Port 2 on the EC1-12 card. 

Step 10 Click Next.

Step 11 In the Circuit Routing Preferences area, review the monitor circuit information. If you want the monitor 
circuit routed on a BLSR protection channel, click Protection Channel Access. 

Step 12 Click Finish.

Step 13 In the Edit Circuit window, click Close. The new monitor circuit appears on the Circuits tab.

Figure 9-1 shows a sample monitor circuit setup. VT1.5 traffic is received by Port 1 of the EC1-12 card 
at Node 1. To monitor the VT1.5 traffic, test equipment is plugged into Port 2 of the EC1-12 card and a 
monitor circuit to Port 2 is provisioned in CTC. (Circuit monitors are one-way.) This example assumes 
circuits have been created.

Figure 9-1 VT1.5 Monitor Circuit Received at an EC1-12 Port

Stop. You have completed this procedure.

NTP-A79 Create a J1 Path Trace

Note You cannot create a J1 path trace on a TL1-like circuit.
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VT1.5 Drop
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Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to circuit traffic. 

Tools/Equipment ONS 15454 cards capable of transmitting and/or receiving path trace must 
be installed. See Table 19-3 on page 19-47 for a list of cards.

Prerequisite Procedures Path trace can only be provisioned on OC-N (STS) circuits. See Chapter 6, 
“Create Circuits and VT Tunnels” for OC-N circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A293 Create a J2 Path Trace
Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 at a node on the network where you will 
create the path trace. If you are already logged in, continue with Step 2.

Step 2 Complete the following tasks as needed: 

• As needed, complete the “DLP-A264 Provision a J1 Path Trace on Circuit Source and Destination 
Ports” task on page 19-46.

• As needed, complete the “DLP-A137 Provision Path Trace on OC-N Ports” task on page 18-15.

Stop. You have completed this procedure.

NTP-A293 Create a J2 Path Trace

Note You cannot create a J2 path trace on a TL1-like circuit.

Note This procedure assumes you are setting up path trace on a bidirectional circuit and setting up transmit 
strings at the circuit source and destination.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66 at a node on the network where you will 
create the path trace. If you are already logged in, continue with Step 2. 

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab.

Step 4 For the VT circuit you want to monitor, verify that the source and destination ports are on a card that can 
transmit and receive the path trace string. 

Note If neither port is on a transmit/receive card, you will not be able to complete this procedure. If 
one port is on a transmit/receive card and the other is on a receive-only card, you can set up the 
transmit string at the transmit/receive port and the receive string at the receive-only port, but you 
will not be able to transmit in both directions.

Step 5 Choose the VT circuit you want to trace, then click Edit.

Step 6 In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A 
detailed map of the source and destination ports appears.

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to circuit traffic. 

Tools/Equipment DS3XM-12 card

Prerequisite Procedures See Chapter 6, “Create Circuits and VT Tunnels” for DS-3 circuit creation 
procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Provision the circuit source transmit string:

a. On the detailed circuit map, right-click the circuit source port (the square on the left or right of the 
source node icon) and choose Edit J2 Path Trace (port) from the shortcut menu. 

b. In the New Transmit String field, enter the circuit source transmit string. Enter a string that makes 
the source port easy to identify, such as the node IP address, node name, circuit name, or another 
string. If the New Transmit String field is left blank, the J2 transmits a string of null characters.

c. Click Apply, then click Close.

Step 8 Provision the circuit destination transmit string:

a. On the detailed circuit map, right-click the circuit destination port and choose Edit Path Trace from 
the shortcut menu.

b. In the New Transmit String field, enter the string that you want the circuit destination to transmit. 
Enter a string that makes the destination port easy to identify, such as the node IP address, node 
name, circuit name, or another string. If the New Transmit String field is left blank, the J2 transmits 
a string of null characters.

c. Click Apply.

Step 9 Provision the circuit destination expected string:

a. On the Circuit Path Trace window, enable the path trace expected string by choosing Auto or 
Manual from the Path Trace Mode drop-down list:

• Auto—The first string received from the source port is automatically provisioned as the current 
expected string. An alarm is raised when a string that differs from the baseline is received. 

• Manual—The string entered in the Current Expected String field is the baseline. An alarm is 
raised when a string that differs from the Current Expected String is received.

b. If you set the Path Trace Mode field to Manual, enter the string that the circuit destination should 
receive from the circuit source in the New Expected String field. If you set Path Trace Mode to Auto, 
skip this step.

c. (Check box visibility depends on card selection.) Click the Disable AIS on C2 Mis-Match check 
box if you want to suppress the alarm indication signal (AIS) when a C2 mismatch occurs.

d. Click Apply, then click Close.

Note It is not necessary to set the format (16 or 64 bytes) for the circuit destination expected string; 
the path trace process automatically determines the format.

Step 10 Provision the circuit source expected string:

a. In the Edit Circuit window (with Show Detailed Map chosen), right-click the circuit source port and 
choose Edit Path Trace from the shortcut menu.

b. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual 
from the Path Trace Mode drop-down list:

• Auto—Uses the first string received from the port at the other path trace end as the baseline 
string. An alarm is raised when a string that differs from the baseline is received.

• Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when 
a string that differs from the Current Expected String is received.

c. If you set the Path Trace Mode field to Manual, enter the string that the circuit source should receive 
from the circuit destination in the New Expected String field. If you set Path Trace Mode to Auto, 
skip this step.
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d. (Check box visibility depends on card selection.) Click the Disable AIS on C2 Mis-Match check 
box if you want to suppress the AIS when a C2 mismatch occurs.

e. Click Apply.

Note It is not necessary to set the format (16 or 64 bytes) for the circuit source expected string; the 
path trace process automatically determines the format.

Step 11 After you set up the path trace, the received string appears in the Received field on the path trace setup 
window. The following options are available:

• Click Hex Mode to display path trace in hexadecimal format. The button name changes to ASCII 
Mode. Click it to return the path trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the path trace default settings (Path Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds if the Path Trace Mode field is set to Auto 
or Manual.

Step 12 Click Close.

The detailed circuit window indicates path trace with an M (manual path trace) or an A (automatic path 
trace) at the circuit source and destination ports. 

Stop. You have completed this procedure.

NTP-A298 Reconfigure Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66. If you are already logged in, continue with 
Step 2.

Step 2 Click the Circuits tab. 

Step 3 Choose the circuits that you want to reconfigure.

Step 4 From the Tools menu, choose Circuits > Reconfigure Circuits.

Step 5 In the confirmation dialog box, click Yes to continue.

Purpose This procedure rebuilds circuits, which might be necessary when a large 
number of circuits are in the PARTIAL status.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A301 Merge Circuits
Step 6 In the notification box, view the reconfiguration result. Click Ok.

Stop. You have completed this procedure.

NTP-A301 Merge Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-66. If you are already logged in, continue with 
Step 2.

Step 2 Click the Circuits tab. 

Step 3 Click the circuit that you want to use as the master circuit for a merge.

Step 4 Click Edit.

Step 5 In the Edit Circuits window, click the Merge tab.

Step 6 Choose the circuits that you want to merge with the master circuit.

Step 7 Click Merge.

Step 8 In the confirmation dialog box, click Yes to continue.

Step 9 In the notification box, view the merge result. Click Ok.

Stop. You have completed this procedure.

Purpose This procedure merges two circuits that create a single, contiguous path but 
are separate circuits because of different circuit IDs or conflicting 
parameters. A merge combines a single master circuit with one or more 
circuits. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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